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1 ABOUT THIS MANUAL 

This manual applies to 963 version 3.20. It provides a description of how to use the 963 when accessing the 963 
Server from a web browser. It is intended for a reader with no knowledge of the 963 who operates it on a daily basis. 
It is assumed that the system has already been set up and engineered to suit user requirements, the user is familiar 
with basic computer use, and has knowledge of BMS. It is divided into several sections. 

About 963 
This section describes 963, and how it works. 

The 963 Client Displays 
This section explains the different displays presented to the user by 963 when they access 963 using a web 
browser. 

Using 963 from a Client 
This section describes how to use 963 from a web browser once it has been installed and engineered. 

After having read and fully understood this manual the user will be familiar with the 963 Supervisor, the 
environment in which it operates, making changes to HVAC equipment parameters, coping with incoming alarms, 
and all other aspects of using the 963 on a day-to-day basis. 

Other relevant documentation is: 
963 Data Sheet (TA200636) 
963 User Guide (TC200635)  
Product Data Sheets 

1.1 Conventions Used in this Manual 

There are numerous items and instructions in this manual, the conventions below are designed to make it quick and 
easy to find and understand the information. 

 Menu commands are in bold type. 
 Buttons and options in dialogue boxes that you need to select are in bold type. 
 The names of text boxes and dialogue boxes are in bold type. 
 Key combinations that you should press appear in normal type. If joined with a plus sign (+), press and 

hold the first key while you press the remaining one(s). For example CTRL+P indicates holding down the 
control key while pressing P. 

 Text you should enter is in Italic type. 
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1.2 Contacting Trend 

Head Office 
Trend Control Systems Ltd 
PO Box 34 
Horsham 
Sussex 
RH12 2YF 
England 

Tel: +44 (0) 1403 211888 
Fax: +44 (0) 1403 241608 

Details of regional offices can be found on our Web site. 

Internet 
Our company web site (www.trend-controls.com) provides information about our products and us, or our support 
web site (http://pnet.trend-controls.com). 

Technical Support 
Our support department provides technical support during normal office hours. Before contacting them ensure that 
you have your Technical Support PIN number available, without this we will be unable to provide you with any 
support. 

Trend Control Systems Ltd. 
Technical Support Department 
PO Box 34 
Horsham 
Sussex 
RH12 2YF 
England 

Tel: +44 (0) 1403 226600 
Email: trendts@trendcontrols.com 
Fax: +44 (0) 1403 226310 

Technical Publications 
Please send any comments on this or any other Trend technical publication to techpubs@trendcontrols.com. 
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2 ABOUT 963 

Once engineered the 963 Supervisor provides the user with a system wide control panel with the facility to monitor 
and change the Building Management System (BMS) ensuring that the HVAC equipment operates safely and 
efficiently. 

The use of colour graphics specially designed for the system displays this information in a simple and effective way. 
Graphs and pages of text information can be used to supplement monitored information. A fast and efficient 
communications network allows this information to be obtained from HVAC equipment that may be scattered miles 
apart in different buildings, on other sites, or even other countries. 

It enables the user to monitor HVAC equipment/building services, and make changes to the way the building is 
controlled using colour graphics displays. Fault reporting, analysis, and data recording features promote efficient 
HVAC equipment operation and effective energy use.  

The information and adjustments available to a user can be exactly tailored to that user’s needs. This means that an 
operator is never presented with more data or options than he or she requires, thus eliminating a major source of 
potential confusion. However, for those whose job function demands it, access can be provided to more detailed 
information. 

When accessed from a web browser, the 963 automatically converts the information into HTML (the language 
understood by web browsers) and passes the information to the client machine for display in a web browser when 
requested. This means that no additional engineering is required to provide the benefits of the 963 across the 
business. Client machines do not require any 963 software to be installed, but must have a connection to a TCP/IP 
network, and a web browser installed. 

963 server operates in two modes graphic mode and text mode depending on the type of web browser accessing the 
server. Graphic mode requires Microsoft Internet Explorer 6 or greater, or Firefox 2, and the Sun Java runtime 
environment J2SE 5.0 or greater. The browser must have JAVA script enabled. Other browsers are only able to 
access the server in text mode. The server can be accessed from web browsers on PCs, PDAs (running Windows 
Mobile 2003 Second Edition or greater), Smartphones (running Window Mobile 5 or greater), and the Nokia 9210i 
although full client functionality is only available on PCs that meet the requirements for graphic mode. Other 
devices are only able to use text mode. 

The table below list the features that are available to a client. 

Feature Notes 
Schematic Pages In graphics mode any page may be displayed, however there may be some slight 

differences in the appearance of the page. WMF and EMF format graphics are not 
supported. Both dynamic and static objects as well as the backdrop will be displayed. In 
text mode graphics are not displayed, the page is reproduced as 3 tables containing live 
data (dynamic objects), actions, and static objects. In both modes static objects, which 
perform unsupported actions are not displayed. Active content such as Excel files is not 
supported on the client. 

963 Actions The following actions are supported CONFIG, DROPALLLINES*, EXECUTESMS*, 
GOTO, GOTO Diary*, GOTO NEXT*, GOTO PREVIOUS*, LOGINAS, LOGOUT, 
MESSAGE*, PLAY*, POPUP*, SEND, SENDAUTO*, SETGENERIC*, 
VIEWGRAPH*, VIEWPOINTS*, VIEWQUERY, WEB. 
*Graphic mode only. 
The EXECUTESMS action is only available if the SMS Direct option has been licensed.

Adjustment of values Fully supported. 
Display of graphs Fully supported. When in text mode a table of the graph’s values is displayed. 
Movement between pages Fully supported. 
Access to device 
configuration mode 

Fully supported. 

Viewing/acknowledgement 
of alarm 

Fully supported in graphic mode only. Only the GOTO, MESSAGE, PLAY, and WEB 
actions are available for use with viewing/acknowledging alarms in a web browser.  

Adjustment of controller 
occupation times 

Fully supported. 

System security Fully supported. 
Device Viewer Only allows viewing of information plus the facility to adjust values, graph values, and 

enter configuration mode on device that support configuration mode. It is not possible to 
learn the system. Graphic mode only. 

Note that 963 has not been tested with all devices and Trend cannot guarantee a particular device’s compatibility 
with 963 server. 
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3 THE 963 CLIENT DISPLAYS 

3.1 963 Server Default Page 

The 963 Servers Default Page shown below is displayed when you connect to the 963 from a client. It enables you 
to log in. 
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3.2 963 Server Start up Page 

The 963 Start up Page shown below is displayed once you have logged in. It provides access to the Schematic 
Page Client Display, Device Viewer, Diary Display and if you are authorised to view alarms contains the Alarm 
Viewer. 

 

Note that for users that only have access to schematics the Schematics Page Display will be shown instead.  
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3.3 Alarm Viewer 

The Alarm Viewer is only available when accessed from a web browser that supports the 963’s graphic mode. It is 
displayed on the 963 Servers Start up Page providing you have authority to view alarms. It displays the alarms that 
have been received. These alarms can be filtered to reduce the amount of data displayed.  

 

The Alarm Viewer has two tabs: 

Alarm History  
Incoming alarms  

Colours are used to indicate whether the alarm is a set alarm or a cleared alarm. A red bell indicates a set alarm, and 
a green bell indicates a cleared alarm. If the alarm has been actioned by the user, a bell will appear with a tick over 
it. The table below shows the different icons.  

Icon Description 

 
Set alarm that has not been actioned. 

 

Set alarm that has been actioned. 

 
Cleared alarm that has not been actioned. 

 

Cleared alarm that has been actioned. 

The Alarm History is colour coded to indicate whether the alarm is current. Red indicates that the alarm is current.  



The 963 Client Displays 

963 Web User Guide TC200685 Issue 5, 11/08/2009 12 

Alarm History tab 
The Alarm History stores all the alarms after they have been processed. This list stores the all the alarms in the 
database that have been processed whether or not they have been actioned by the user. The alarms can be viewed in 
chronological order or a summary view. 

Summary View - This gives a count for each alarm type for each point.  
Chronological View - a systematic alarm history sorted by time order. 

Incoming Alarms tab 
The Incoming Alarms contains the last 100 alarms to be received as they arrive. New alarms appear at the top of 
the list when they are first received. 

3.4 Configuration Mode Display 

The Configuration Mode Display, shown below, allows access to configuration mode on a specified IQ System 
device. It allows simple adjustments to be made to the strategy. When in configuration mode all the screen prompts 
originate from the controller and all keyboard inputs are sent to the controller when Submit is clicked.  
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3.5 Device Viewer 

The Device Viewer is only available when accessed from a web browser that supports the 963’s graphic mode. It 
enables inputs, outputs, adjustments, time zones, and critical alarms from the selected part of the system to be 
displayed, and for values to be adjusted, or graphed. E.g. if the internetwork is selected, all values from the 
internetwork are displayed. If a particular Lan is selected only values from that Lan are displayed.  

 

The Device Viewer is divided into two different areas: 

Data Display 
Navigator  

Data Display 
The Data Display contains the requested modules, it is colour coded to indicate whether the alarm is current. Red 
indicates that the alarm is current. Once the values have been displayed it is possible to adjust values, display a 
graph, or enter the configuration mode of IQ System devices that support configuration mode. The display contains 
a number of columns that display the values of the inputs, outputs, adjustments, time zones, and critical alarms from 
the part of the system selected in the Navigator. 
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Column Description 
Icon Contains an icon that indicates the module type. 

 
Sensor Modules 

 Digital Input Modules 

 
Virtual Sensor Modules 

 
Critical Alarm Modules 

 
Knob Modules 

 
Switch Modules 

 

Time zone Modules 

 Analogue Driver Modules 
 Digital Driver Modules 

 
Plot Modules 

These icons may also overlayed with icons indicating the modules alarm state, and whether it can be 
adjusted. 

 
Module in alarm but alarm has been acknowledged 

 
Module in alarm 

 
Module value can be adjusted. 

 
Module value cannot be adjusted. 

 There is a graph available for the module. 
 

Label The module label. For plot modules from pre IQ3 controllers will display the label of the module whose 
value the plot module is recording. 

Value The current value of the module. 
Units The value’s engineering units. 
Error 
Description 

A description of any error that exists for the value. 

Alarm 
Code 

The alarm code for the alarm if the module is in an alarm condition. 

Item A code indicating the module type and number (e.g. S1 specifies Sensor module number 1) 

S Sensor Modules 
I Digital Input Modules 
W Switch Modules 
Z Time zone Modules 
K Knob Modules 
D All Driver modules for IQ system sites, Analogue Driver Modules for BACnet sites 
J Digital Driver Modules for BACnet sites 
X Virtual Sensor Modules 
P Plot Module 
M Critical Alarm Modules  

LAN The Lan number of the controller containing the module 
OS The network address of the controller containing the module 
Tele The phone number or IP address used to address the site containing the module. 
Pin Level The PIN level required to adjust the value. 
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The display also contains a number of buttons that enable the types of modules displayed to be selected. 

Icon What is Displayed 

 
Sensors 

 Digital Inputs 

 
Virtual sensors (calculated MKT values) 

 
Critical Alarms 

 
Knobs 

 
Switches 

 Time Zones 

 Analogue Driver 

 Digital Driver 

 
Plots 

 

Refreshes the values. 

 

This causes 963 to only display items of the selected item types whose label matches the search string.

Inputs Select/deselects all inputs 
Adjustments Select/deselects all adjustments 
Drivers Select/deselects all drivers 
Plots Select/deselects plots 

Navigator 
The Navigator displays a tree view of the system to which 963 is connected, enabling the level at which the system 
is displayed in the Data Display to be selected. For example, clicking a Lan will display all the points with labels on 
that Lan. Access to this display can be restricted to certain users. Icons indicate the type of object. The table below 
lists the different icons. 

Icon  
Supervisors 

Description 

 

921 Supervisor 

 

940 Supervisor 

 

942 Supervisor 

 

943 Supervisor 

 

945 Supervisor 

 

950 Supervisor 

 

963 Supervisor, 962 Supervisor, S2 Supervisor, or ViewPoint 

 

NDP 

 

IQView 

Devices 

 

ANC 
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Icon  
Supervisors 

Description 

 

BACnet Device 

 

CNC 

 

FNC 

 

ID200 

 

INC 

 

IQ100 Controller 

 

IQ111 Controller 

 

IQ131 Controller 

 

IQ151 Controller 

 

IQ2 Controller 

 

IQ3 Controller 

 

IQ70 Controller 

 

IQ90 Controller 

 

IQ EYE Collector 

 

IQL Controller 

 

Novar Logic 1 Controller 

 

Non IQ system device 

 

PNC 

 

TONIC 

 

TOPS 

 

XNC 

Site Structure 

 

BACnet Lan 

 

Local site 

 

Novar Logic 1 Lan 

 

Remote Site 
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Icon  
Supervisors 

Description 

 

Trend Lan 

 

Unknown Lan 

General 

 

Unknown Device 

3.6 Diary Display 

The Diary Client Display, shown below, allows the occupation times of the controller to be viewed, and adjusted. 
Exceptions to the normal working times can be setup, and edited as required. 
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3.7 Schematic Page Client Display 

The Schematic Page Client Display, shown below, enables a schematic page to be displayed. When accessed from 
a web browser that supports the 963’s graphic mode it displays the pages virtually the same as they appear on the 
server machine. The display allows you to view the information, clicking the different objects will enable you to 
perform different tasks. The page display should make is clear what can be done. Right clicking anywhere on the 
page background displays a menu that provides access to the help system, and enables you to navigate to the next or 
previous page. There is no Navigator on the client; navigation must be provided through buttons engineered directly 
on the pages.  

 

When accessed from a browser that does not support the 963’s graphic mode the 963 Server displays the 
information in text mode and graphics are not displayed. The page is reproduced as 3 tables containing live data, 
actions, and additional information. There are a number of different text mode layouts to allow for different device 
types. The appropriate layout for the client device is automatically selected. Each layout provides the same 
functionality, but data displayed varies to accommodate different screen sizes and aspect ratios.  
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3.8 Server Status Page 

The Server Status Page shown below provides information about the 963 Server's status. The information is split 
into several tables containing different types of information described below. 

 

Table Description 
Server Information This provides the following information about the 963 Server: Lan number, network 

address, version, time on, free disk space, screen resolution, and the number of clients 
currently connected. 

Clients This table provides information about the clients currently connected 
Cache This table provides information about all current Trend communications requests 
IQ Comms Statistics This table provides information about any device that has reported a communications 

error. 
IP Comms Statistics This table provides support information for current IP connection problems. 

The information displayed is dependant on your access rights. To view all the information you must log in as a user 
with the authority to configure workgroups and users, user without these access rights will only be able to see the 
server information. 

Users with the authority to configure workgroups and users will also have access to the View remote connections 
button which displays a separate window containing information about connections to remote sites made by the 963 
Server, and enable the connection to be dropped if required. 
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4 USING 963 FROM A CLIENT 

Information from 963 can easily be accessed using a web browser, over any TCP/IP network (e.g. the company 
Intranets, or the Internet). All that is required is the URL of the 963 Server and a valid user name and password. 
Once connection to the 963 Server has been made, it is possible to move between pages, adjust analogue values, 
adjust digital values, view graphs, and look at alarms, or enter configuration mode on Pre IQ3 controllers by 
clicking the appropriate hotspot, depending on your level of access to 963. 

When accessed from a web browser the information displayed and features available depend on the type of browser 
being used. 

963 Clients running on a PC may be of any configuration providing they are running TCP/IP networking protocol, 
have an Ethernet card, and a web browser installed. For full graphics capabilities (graphic mode) Internet Explorer 
v6.0 or greater, or Firefox 2 (recommended Internet Explorer version 6 or greater) and the Sun Java runtime 
environment J2SE 5.0 or greater is required. Other browsers will provide a text only display (text mode). 963 clients 
running on PDAs require Windows Mobile 2003 Second Edition or greater. 963 clients running on smartphones 
require Windows Mobile 5 or greater. Clients running on PDAs, the Nokia 9210i, and smartphones only support text 
mode.  

Note that 963 has not been tested with all devices and Trend cannot guarantee a particular device’s compatibility 
with 963 server. 

There is a summary of accessing 963 from a web browser in the following section: 

Basic Use  

For a more detailed description of the different tasks see the following sections. 

Action Alarms  Adjust Occupation Times  
Adjust Values  Display a Schematic Page  
Display Graphs  Display the IQ System  
Display IQ3 Web Pages Enter Configuration Mode on Pre IQ3 Controllers 
Playback Recorded Data  Setup Exception Templates  
View Alarms  View Occupation Times  
View Server Status   

Note that any operations with BACnet devices are only possible if 963 is connected to TOPS. 

4.1 Basic Use 

This section of the manual describes the most basic use of the 963 when accessing it from a web browser. Most of 
the information presented to the user is displayed on schematic pages that have been set up. Clicking certain parts of 
the page will cause something to happen; exactly what happens is dependent on how 963 has been set up. When the 
mouse pointer is moved over a part of the screen that will do something it changes to a hand ( ). These areas of the 
screen will generally be obvious because of text that appears in, or next to them. 

To access the 963 Server from a web browser: 
1. Connect to the 963 Server as described in the ‘Connect to 963 Server’ section of this manual. 
2. Log in by entering your user name and password and clicking Log in as described in the ‘Log In’ section of 

this manual. Remember the username is case sensitive. 

It is necessary to log in so that 963 knows what information and facilities you are able to access. 

The 963 Server’s Start up page is displayed. This page provides access to schematic pages, the Device 
Viewer, server status, enables you to log off, and will display the alarm viewer if you have access to it, and 
are accessing 963 Server in graphic mode. If you only have access to schematics the Schematic Page 
Display is displayed. 

3. Having accessed the 963 select the required display using the buttons at the top of the display. These are listed 
in the table below. 

Button Description 
Device Viewer Displays the Device Viewer. 
Diary Displays the Diary Display 
Log off Logs you off. 
Schematics Displays the schematic page for your log in. 
Server Status Displays information about the 963 Server. 
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4. Once you have selected the required display you will be able to view the information such as schematic 
pages, alarms, the Device Viewer, and server status depending on your level of authority. Clicking the 
different objects will enable you to perform different tasks, the display should make it clear what can be 
done. The table below lists the common tasks; you should see the corresponding section of this manual for 
more details. 

Action Alarms  Adjust Occupation Times  
Adjust Values  Display a Schematic Page  
Display Graphs  Display the IQ System  
Display IQ3 Web Pages Enter Configuration Mode on Pre IQ3 Controllers 
Playback Recorded Data  Setup Exception Templates  
View Alarms  View Occupation Times  
View Server Status   

5. Log off when use of the 963 is finished. 

4.1.1 Connect to 963 Server 

It is possible to connect to the 963 Server from anywhere, providing a TCP/IP connection can be made to the 963 
Server. 

The 963 server can operate in one of two modes, graphic, or text depending on the browser or device being used as 
the client. For PCs 963 Clients may be of any configuration providing they are running TCP/IP networking protocol, 
and have an Ethernet card, and have a web browser installed. For full graphics capabilities (graphic mode) Internet 
Explorer v6.0 or greater, or Firefox 2 (recommended Internet Explorer version 6 or greater) and the Sun Java 
runtime environment J2SE 5.0 or greater is required. Other browsers will provide a text only display (text mode). 
PDAs running Windows Mobile 2003 Second Edition or greater, the Nokia 9210i and smartphones running Window 
Mobile 5 or greater are only able to access the server in text mode.  

Note that 963 has not been tested with all devices and Trend cannot guarantee a particular device’s compatibility 
with 963 server. 

There are differences between the two modes 

To connect to the 963 Server: 
1. Run the web browser. 
2. Enter the URL of the 963 server. If the 963 has been set up to use a TCP/IP port other than port 80 specify 

the port number separated with a colon e.g. http:// 963:6000. 

This will be the IP address or name of the personal computer running 963 Server. The 963 Server’s 
default page shown below is displayed. 

 

Tip: The engineer may have created a short cut that carries out steps (1) and (2). Simply click that. 

Note that a different page may be displayed this is because the engineer has engineered it that way. 
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3. When you enter a valid user name and password a page of information should be displayed. If there is a 
problem connecting to the 963, an error message will be displayed; these messages are explained in the 
‘Error Messages’ section of this manual. 

Note that for security reasons it is only possible to access a 963 Secure Server in graphic mode. 

4.1.2 Log In 

Before 963 can be used, it is necessary to log in so that 963 knows what information and facilities you are able to 
access. 

To log in: 
1. Connect to the 963 Server as described in the ‘Connect to 963 Server’ section of this manual. 
2. In the Username box enter you 963 username. Remember the username is case sensitive. 
3. In the Password box enter your password. 

Note that passwords are case sensitive. 

4. Click Login. 963 Server Start up Page is displayed. 

This page provides access to schematic pages, the Device Viewer, Diary Display, server status, enables you to log 
off and will display the alarm viewer if you have access to it, and are accessing 963 Server in graphic mode. 

4.1.3 Log Off 

Once use of 963 is finished, it is advisable to log off to prevent unauthorised changes being made. 

To log off: 
1. Display the 963's start up page as described in the ‘Display the 963’s Start up Page’ section of this manual. 
2. Click Log off. You will be logged off. 
3. Close any open web browser windows. 

Note that if left unattended for a period of time 963 may automatically log the current user off if it has been 
configured in this way. 

4.2 Display a Schematic Page 

Most of the information presented to the user is displayed on schematic pages that have been set up. Clicking certain 
parts of the page will cause something to happen; exactly what happens is dependent on how 963 has been set up. 
When the mouse pointer is moved over a part of the screen that will do something it changes to a hand ( ). These 
areas will generally be obvious because of text that appears in, or next to them. 

When the 963 Server is accessed in text mode only a subset of the features is available, and data in schematics is 
displayed as a simple text based table. This page is split in to three areas. The first contains all the dynamic objects 
on the page. If they are displayed as a button then they allow the value to be adjusted. The second area on the page 
contains any links on the page, and the final area displays any static text. Values on text mode schematic pages are 
not automatically refreshed, and must be manually refreshed using the button on the screen, or the browser's refresh 
button. 

To view schematic pages: 
1. Connect to the 963 Server as described in the ‘Connect to 963 Server’ section of this manual. 
2. Log in by entering your user name and password and clicking Log in as described in the ‘Log In’ section of 

this manual. The 963 Server Start up Page is displayed.  
3. Click Schematics. A separate window is opened containing the schematic page that has been set as the 

page that is displayed when you log in. 
4. To move from page to page click the button or picture that provides access to the required page.  

As you move from page to page, 963 keeps a record of the pages and enables you to move backwards and 
forwards through the pages. To do this right click the page and click Back, or Forward. 

5. Once the required page is displayed you will be able to view the information, clicking the different objects 
will enable you to perform different tasks, the page display should make it clear what can be done.  

Values can be adjusted by clicking the button or picture that enables the value to be changed and specifying 
the new value. 

Compact graphs can be displayed by clicking the value that is to be graphed. Precision graphs can be 
displayed by right-clicking the value and clicking Collect full precision log graph(s). 

6. Log off when use of the 963 is finished. 
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4.3 Adjust Values 

4.3.1 Adjust a Knob in a Trend Device 

The value of knobs in Trend devices can be adjusted from a schematic page or from the Device Viewer. 

To adjust a knob in a Trend device: 
1. Display the page containing the knob that is to be adjusted as described in the ‘Display a Schematic Page’ 

section of this manual, and click the button or picture that enables the knob to be changed.  

Or 

View the knob that is to be adjusted in the Device Viewer, as described in the ‘Display the IQ System’ 
section of this manual, right click the knob that is to be adjusted, and click Adjust Point.  

The Adjust Value dialogue box is displayed. 

 

2. In the New Value box enter the new value. 

Note that selecting the Show keypad check box a software keypad on the screen, which can be used to enter 
the new value. 

3. Click Enter. In some cases, a message will be displayed asking for confirmation of the change. Click Yes. 

If you are accessing the 963 Server using text mode the adjustment can only be made from a schematic page and is 
made differently. 

To adjust a knob in a Trend device in text mode: 
1. Display the page containing the value that is to be adjusted as described in the ‘Display a Schematic Page’ 

section of this manual. 
2. In the box next to the value enter the new value. 

3. Click  to send the data to the controller. 

4.3.2 Adjust a Knob (Analogue Value) in a BACnet Device 

Analogue values in BACnet devices are represented in 963 as knobs; these can be adjusted from a schematic page or 
from the Device Viewer. 

To adjust knob (analogue value) in a BACnet device: 
1. Display the page containing the knob that is to be adjusted as described in the ‘Display a Schematic Page’ 

section of this manual, and click the button or picture that enables the knob to be changed.  

Or 

View the knob that is to be adjusted in the Device Viewer, as described in the ‘Display the IQ System’ 
section of this manual, right click the knob that is to be adjusted, and click Adjust Point.  

The BACnet Device dialogue box is displayed. 

 

2. Click Adjust. The Adjust Value dialogue box is displayed. 

 

3. In the New Value box enter the new value. 

Note that selecting the Show keypad check box a software keypad on the screen, which can be used to enter 
the new value. 

4. Click Enter. In some cases, a message will be displayed asking for confirmation of the change. Click Yes. 

If you are accessing the 963 Server using text mode the adjustment can only be made from a schematic page and is 
made differently. 
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To adjust knob (analogue value) in a BACnet device in text mode: 
1. Display the page containing the value that is to be adjusted as described in the ‘Display a Schematic Page’ 

section of this manual. 
2. In the box next to the value enter the new value. 

3. Click  to send the data to the controller. 

4.3.3 Adjust a Switch in a Trend Device 

Digital values in BACnet devices are represented in 963 as switches; these can be adjusted from a schematic page or 
from the Device Viewer. 

To adjust a switch in a Trend device: 
1. Display the page containing the switch that is to be adjusted as described in the ‘Display a Schematic Page’ 

section of this manual, and click the button or picture that enables the switch to be changed.  

Or 

View the switch that is to be adjusted in the Device Viewer, as described in the ‘Display the IQ System’ 
section of this manual, right click the switch that is to be adjusted, and click Adjust Point.  

The Adjust Point dialogue box is displayed. 

 

2. Click the Yes to change the value, or No to leave it unchanged. 

If you are accessing the 963 Server using text mode the adjustment can only be made from a schematic page and is 
made differently. 

To adjust a switch in a Trend device in text mode: 
1. Display the page containing the switch that is to be adjusted, as described in the ‘Display a Schematic 

Page’ section of this manual. 
2. In the box next to the value select either Set ON or Set OFF. 

3. Click  to send the data to the controller. 

4.3.4 Adjust a Switch (Digital Value) in a BACnet Device 

Switches in a Trend device e.g. controller can be adjusted from a schematic page or from the Device Viewer. 

To adjust a switch in a Trend device: 
1. Display the page containing the switch that is to be adjusted as described in the ‘Display a Schematic Page’ 

section of this manual, and click the button or picture that enables the switch to be changed.  

Or 

View the switch that is to be adjusted in the Device Viewer, as described in the ‘Display the IQ System’ 
section of this manual, right click the switch that is to be adjusted, and click Adjust Point.  

The BACnet Device dialogue box is displayed. 

 

2. Click Adjust. The Adjust Point dialogue box is displayed. 

 

3. Click the Yes to change the value, or No to leave it unchanged. 

If you are accessing the 963 Server using text mode the adjustment can only be made from a schematic page and is 
made differently. 

To adjust a switch in a Trend device in text mode: 
1. Display the page containing the switch that is to be adjusted, as described in the ‘Display a Schematic 

Page’ section of this manual. 
2. In the box next to the value select either Set ON or Set OFF. 

3. Click  to send the data to the controller. 
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4.3.5 Adjust a Module Parameter 

It is possible to adjust certain parameters of the configuration modules within IQ controllers directly from a 
schematic page or the Device Viewer. 

To adjust a module parameter: 
1. Display the page containing a value from the controller whose configuration parameters are to be adjusted 

 as described in the ‘Display a Schematic Page’ section of this manual. 

Or 

View the value from the controllers whose configuration parameters are to be adjusted in the Device 
Viewer. 

2. Right-click the value, and click Edit Item. The View as Points dialogue box is displayed. 

 

3. Right-click the parameter that is to be changed, and click Adjust Point from the menu that is displayed. 
The Enter new value for dialogue box is displayed. 

 

4. In the box enter the new value. 

5. Click OK, to return to the View as Points dialogue box and then  to close the View as Points dialogue 
box. 
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4.3.6 Relinquish Control of a BACnet Value 

When 963 adjusts a value in a BACnet device it writes the value into the value's priority array. The value will 
remain in the array, and be used when it is the highest. If required the 963's adjustment can be removed from the 
array by relinquishing control. 

To relinquish control of a BACnet value: 
1. Display the page containing the value for which you want to relinquish control, and click the button or 

picture that enables the value to be changed.  

Or 

View the value for which you want to relinquish control in the Device Viewer, right-click the value, and 
click Adjust Point. 

The BACnet Device dialogue box is displayed. 

 

3. Click Relinquish control. 

To relinquish control of a BACnet value in text mode: 
1. Display the page containing the value for which you want to relinquish control, and click the button or 

picture that enables the value to be changed, as described in the ‘Display a Schematic Page’ section of this 
manual. 

2. Click   next to the value. 

4.4 Alarms 

4.4.1 View Alarms 

If you accessing the 963 Server in graphic mode, it indicates when an alarm has been received in the Alarm Viewer 
which is displayed on the 963’s Start up page. Other actions such as the display of a message box may have been 
engineered. 

Alarms are shown as they arrive on the Incoming Alarms tab of the Alarm Viewer. This list stores the last 100 
alarms. After alarms have been processed, they will appear in the Alarm History tab. In both of the lists icons 
indicate whether or not an alarm has been actioned by a user. Colours are used to indicate whether the alarm is a set 
alarm or a cleared alarm. A red bell indicates a set alarm, and a green bell indicates a cleared alarm. If the alarm has 
been actioned by the user the bell with appear with a tick over it. The table below shows the different icons.  

Icon Description 

 
Set alarm that has not been actioned. 

 

Set alarm that has been actioned. 

 
Cleared alarm that has not been actioned. 

 

Cleared alarm that has been actioned. 

The Alarm History is colour coded to indicate whether or not the alarm is current. Red indicates that the alarm is 
current. 

There are a number of different ways in which alarms can be viewed: 

View Incoming Alarms 
View Alarm History 
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4.4.1.1 View Incoming Alarms 

Alarms are shown as they arrive on the Incoming Alarms tab of the Alarm Viewer. This list stores the last 100 
alarms. 

To view incoming alarms: 
1. Access the 963 Server as described in the ‘Connect to the 963 Server’ section of this manual. 
2. Display the 963’s start up page as described in the ‘Display the 963’s Start up Page’ section of this manual. 
3. Click the Incoming Alarms tab. 

If the text does not fit in the column, the column can be resized by dragging the edge to the correct size. The list can 
be refreshed by clicking Ask for new alarms.  

The Incoming Alarms contains the last 100 alarms to be received as they arrive. Once full the earliest alarm will be 
removed from the list (it will still be visible in the Alarm History). If required the list can be completely emptied 
(any alarm will still be visible in the Alarm History) by clicking Clear List. 

Note that this feature is only available accessing the 963 Server in graphic mode. 

4.4.1.2 View Alarm History 

Once alarms have been processed they will appear on the Alarm History tab of the Alarm Viewer. This list stores 
all the alarms in the database that have been processed whether or not they have been actioned by the user. The 
alarms can be viewed in chronological order or a summary view that provides a count for each alarm type. 

To view alarm history: 
1. Access the 963 Server as described in the ‘Connect to the 963 Server’ section of this manual. 
2. Display the 963’s start up page as described in the ‘Display the 963’s Start up Page’ section of this manual. 
3. Click the Alarm History tab. 
4. Click Refresh Filters to ensure that the list of filters available is up-to-date. 
5. Select the Summary View check box to view the alarms in the Summary View, or clear it to view the 

alarms in the Chronological View. 
6. In the Filter box click the alarm filter or alarm group for which alarms are to be viewed. 
7. In the Post Filter box click the alarms that are to be viewed. 

Alarm Description 
All Alarms All alarms that have been processed 
Current Alarms Any alarm not cleared. 
Alarms Requiring Actioning Alarms which the user has not yet actioned. 
Historic Actioned Alarms Cleared alarms that have been actioned. 

8. If the Chronological View has been selected, select the required date range from the date range box. To 
specify a specific date range click Custom to display another dialogue box and specify the first and last 
date in the range, and click OK. 

9. The required alarms will now be displayed. To view the next 50 alarms click Next, and to view the 
previous 50 alarms click Last. 

If the text does not fit in the column, the column can be resized by dragging the edge to the correct size. The alarms 
can be sorted by any of the columns in the display by clicking that column. The list can be refreshed by clicking 
Refresh History.  

Note that this feature is only available accessing the 963 Server in graphic mode. 



Using 963 From a Client 

963 Web User Guide TC200685 Issue 5, 11/08/2009 29

4.4.1.3 Specify What Columns are Displayed 

It is possible to determine which columns are displayed in the Alarm History, and the Incoming Alarms list. 

To specify which columns are displayed 
1. View either the Incoming Alarms, or the Alarm History as described in the ‘View Incoming Alarms’, or 

‘View Alarm History’ sections of this manual. 
2. Click Set up table. A dialogue box is displayed. 

 

3. Select the check boxes next to the column name to specify which columns are to be displayed. 
4. Click OK. 

Note that this feature is only available accessing the 963 Server in graphic mode. 

4.4.1.4 Hide Alarm Panels 

If an alarm has caused an alarm panel to be displayed it is possible to hide the alarm panel for 2 minutes if it is not 
currently convenient to deal with the alarm e.g. you are currently working on something else that is more important. 

To hide the current alarm panel: 

1. Click  on the alarm panel that is to be hidden. 

To hide all alarm panels: 

1. Click  on any alarm panel. 

4.4.2 Action Alarms 

Alarms that have been sent to 963 must be actioned to indicate that the alarm has been seen. When actioning alarms 
you are required to enter a description of the action taken in response to the alarm. 

To action alarms: 
1. View the alarm(s) that are to be actioned as described in the ‘View Alarms’ section of this manual. 
2. Click the alarm(s) that are to be actioned (to select more than one alarm hold down the CTRL key and click 

the required alarms). To select all the alarms click Select All, to deselect all selected alarms click Unselect 
all. 

3. Click Action Selected Alarms. The Alarm Action Description dialogue box is displayed. 

 

4. In the box enter some text describing the action to assist future faultfinding (e.g. the action taken because of 
the alarm). 

5. Click OK. 

Note that this feature is only available when accessing 963 Server in graphic mode. 
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4.4.2.1 Action Alarms from an Alarm Panel 

Alarms can be actioned from an alarm panel. 

To action alarms: 

1. Click  in the alarm panel. The alarm history will be displayed showing the alarms that require 
acknowledgement associated with the alarm panel. 

2. Click the alarm(s) that are to be actioned (to select more than one alarm hold down the CTRL key and click 
the required alarms). To select all the alarms click Select All, to deselect all selected alarms click Unselect 
all. 

3. Click Action Selected Alarms. The Alarm Action Description dialogue box is displayed. 

 

4. In the box enter some text describing the action to assist future faultfinding (e.g. the action taken because of 
the alarm). 

5. Click OK. 

Note that this feature is only available when accessing 963 Server in graphic mode. 

4.4.3 Mute an Alarm Panel 

If an alarm has displayed an alarm panel that is set to beep it is possible to mute the beep. 

To mute the beep: 

1. Click  on the alarm panel that is to be muted. 

Clicking the button again will cause the beep to be restarted. 

4.4.4 Run a Manual Alarm Action 

Manual alarm actions enable a specific action to be run by the user when an alarm occurs. This gives the operator 
control over the display and prevents the situation where 963 is too busy jumping to pages for the user to interact 
with the rest of the system. 

To run a manual alarm action: 

1. Click  in required alarm panel when it is displayed. 

4.4.5 Run Alarm Actions Manually 

If the automatic running of alarm actions has been turned off, or for some reason it is necessary to rerun a particular 
action, the alarm actions can be run manually. 

To run an alarm action manually: 
1. View incoming alarms as described in the ‘View Incoming Alarms’ section of this manual. 
2. Click the alarm for which the action is to be run. 
3. Click Emulate Alarm Action. 

Note that this feature is only available accessing the 963 Server in graphic mode. 

4.4.6 Turn Alarm Actions ON/OFF 

The actions that occur when an alarm is received can be turned ON/OFF by the user. 

To turn the alarm action ON/OFF: 
1. View incoming alarms as described in the ‘View Incoming Alarms’ section of this manual. 
2. Clear the Auto execute actions check box. 

This is not a permanent setting. 

Note that this feature is only available accessing the 963 Server in graphic mode. 
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4.5 Display Graphs 

963 can display either compact or precision graphs of data logged in IQ controllers. When a compact log is 
requested the controller transmits the highest and lowest values in the log and every other value as a percentage of 
the range. This allows for rapid transmission of data and for very large numbers, but has an error of 1% of the range 
of values in the logging channel.  

Precision graphs ensure high accuracy but take longer to receive. More importantly the transfer rate is much slower. 
For this reason users can limit the number of points retrieved for a full-precision log collection and should not use 
this method to collect 1-second logs. This method would always be the preferred method for meter readings as there 
is no loss of raw data. 

4.5.1 Display a Graph from a Schematic Page 

Compact graphs are not available for values logged by periodic and triggered plots, or values from TOPS devices. If 
compact logging is not supported precision graphs are used. 

To display a graph from a schematic page: 
1. Display the schematic page containing the value for which logged data is to be graphed as described in the 

‘Display a Schematic Page’ section of this manual. 
2. Right click the value and click Collect Compact Log Graph or Collect full precision log graph from the 

displayed menu.  

Or 

If the value is being logged by more than one plotting channel point to Collect Compact Log Graph or 
Collect full precision log graph and click the required plotting channel. 

Or 

If the value is from a sensor or plot module click the value that is to be graphed. If the sensor is being 
logged by more than one plotting channel the first plotting channel will be used. 

The graph is displayed. 
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Clicking List displays the co-ordinates of the graph see the ‘Display Graph Data’ section of this manual. 
The graph can be viewed in more detail by dragging the mouse over the required area of the graph see the 
‘Zoom in and Out of a Graph’ section of this manual for more details. As the mouse is moved over the 
graph the values for points on the graph are displayed to stop this press ALT+V or right click the graph and 
click Show trace value window see the 'Display a Point's Co-ordinates' section of this manual. To display 
a horizontal grid, on the View menu point to Grid lines and then click Left or Right, depending which axis 
is to be used for the grid. To display a vertical grid, on the View menu point to Grid lines and then click 
Time axis, see the 'Display a Grid on a Graph' section of this manual. To display a chart on the Data menu 
click Chart points see the 'Display a Chart' section of this manual. To display data that 963 has recorded 
for the graph, on the Data menu click Load Recorded Data, see the 'Playback a Recorded Graph' section 
of this manual for more details.  

3. Click OK to close the graph. 

To display a graph from a text mode schematic page: 
1. Display the schematic page containing the value for which logged data is to be graphed as described in the 

‘Display a Schematic Page’ section of this manual. 

2. Click on the sensor label to collect the first plot, or click   for the required plot. 
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4.5.2 Display a Graph from the Device Viewer 

Compact graphs are not available for values logged by periodic and triggered plots, or values from TOPS devices. If 
compact logging is not supported precision graphs are used. 

To display a graph from the Device Viewer: 
1. View the values that are to be graphed in the Device Viewer as described in the ‘Display the IQ System’ 

section of this manual. Values that can be graphed are indicated by a . 
2. Right click the value and click Collect Compact Log Graph or Collect full precision log graph from the 

displayed menu. 

Or 

If the value is being logged by more than one plotting channel point to Collect Compact Log Graph or 
Collect full precision log graph and click the required plotting channel. 

Or 

To graph more than one value hold down the CTRL key and click the required values and right-click one of 
the values and click Collect Compact Log Graph or Collect full precision log graph. When graphing 
more than one value 963 will use the first plotting channel for each value. 

The graph is displayed.  

 

Clicking List displays the co-ordinates of the graph see the ‘Display Graph Data’ section of this manual. 
The graph can be viewed in more detail by dragging the mouse over the required area of the graph see the 
‘Zoom in and Out of a Graph’ section of this manual for more details. As the mouse is moved over the 
graph the values for points on the graph are displayed to stop this press ALT+V or right click the graph and 
click Show trace value window see the 'Display a Point's Co-ordinates' section of this manual. To display 
a horizontal grid, on the View menu point to Grid lines and then click Left or Right, depending which axis 
is to be used for the grid. To display a vertical grid, on the View menu point to Grid lines and then click 
Time axis, see the 'Display a Grid on a Graph' section of this manual. To display a chart on the Data menu 
click Chart points see the 'Display a Chart' section of this manual. To display data that 963 has recorded 
for the graph, on the Data menu click Load Recorded Data, see the 'Playback a Recorded Graph' section 
of this manual for more details.  

3. Click OK to close the graph. 

Note that this feature is only available accessing the 963 Server in graphic mode. 
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4.5.3 Load a Graph Definition 

The specifications about which traces appear on a graph, how the grid etc is set up can be saved as a definition on 
the server. These set ups can be loaded later. The set up of the graph is retained, but the latest data will be displayed. 
This saves time if there are graph traces that are viewed and analysed in the same way on a regular basis. 

This feature is only when available accessing the 963 Server in graphic mode. 

To load a graph definition: 
1. Display the page containing the button that enables the graph set up to be loaded, as described in the 

‘Display a Schematic Page’ section of this manual. 
2. Click the button or graphic that displays the required graph set up. The graph is displayed. 

 

Clicking List displays the co-ordinates of the graph see the ‘Display Graph Data’ section of this manual. 
The graph can be viewed in more detail by dragging the mouse over the required area of the graph see the 
‘Zoom in and Out of a Graph’ section of this manual for more details. As the mouse is moved over the 
graph the values for points on the graph are displayed to stop this press ALT+V or right click the graph and 
click Show trace value window see the 'Display a Point's Co-ordinates' section of this manual. To display 
a horizontal grid, on the View menu point to Grid lines and then click Left or Right, depending which axis 
is to be used for the grid. To display a vertical grid, on the View menu point to Grid lines and then click 
Time axis, see the 'Display a Grid on a Graph' section of this manual. To display a chart on the Data menu 
click Chart points see the 'Display a Chart' section of this manual. To display data that 963 has recorded 
for the graph, on the Data menu click Load Recorded Data, see the 'Playback a Recorded Graph' section 
of this manual for more details.  

3. Click OK to close the graph. 
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4.5.4 Playback Recorded Data 

If data logged in a controller has been recorded by 963 it can be displayed as a graph. 

To playback recorded data: 
1. Display a graph from a schematic page or from the Device Viewer for the value for which data is to be 

played back as described in the appropriate section of this manual.  
2. On the Data menu click Load Recorded Data. The Choose a date range dialogue box is displayed. 

 

3. Click the required option to specify the date range for the data that is to be played back. To specify a 

specific date range click Custom and specify the first and last date in the range by clicking  next to 
the Start and End boxes to display a dialogue box for entering the required data, 

4. Click OK. The graph is displayed. 

 

Clicking List displays the co-ordinates of the graph see the ‘Display Graph Data’ section of this manual. 
The graph can be viewed in more detail by dragging the mouse over the required area of the graph see the 
‘Zoom in and Out of a Graph’ section of this manual for more details. As the mouse is moved over the 
graph the values for points on the graph are displayed to stop this press ALT+V or right click the graph and 
click Show trace value window see the 'Display a Point's Co-ordinates' section of this manual. To display 
a horizontal grid, on the View menu point to Grid lines and then click Left or Right, depending which axis 
is to be used for the grid. To display a vertical grid, on the View menu point to Grid lines and then click 
Time axis, see the 'Display a Grid on a Graph' section of this manual. To display a chart on the Data menu 
click Chart points see the 'Display a Chart' section of this manual.   

Note that this feature is only available when accessing the 963 Server in graphic mode. 
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4.5.5 Display a Chart 

963 allows a chart of values from a controller to be displayed. This feature is only available when accessing the 963 
Server in graphic mode, and is not supported for values from BACnet devices. 

To chart values: 
1. Display a graph from a schematic page or from the Device Viewer for the sensor that is to be charted as 

described in the appropriate section of this manual.  
2. On the Data menu click Chart points. The selected value(s) will now be charted at a refresh rate of 30s. 

To return to the logged data on the Data menu click Original View. 

Clicking List displays the co-ordinates of the graph see the ‘Display Graph Data’ section of this manual. 
The graph can be viewed in more detail by dragging the mouse over the required area of the graph see the 
‘Zoom in and Out of a Graph’ section of this manual for more details. As the mouse is moved over the 
graph the values for points on the graph are displayed to stop this press ALT+V or right click the graph and 
click Show trace value window see the 'Display a Point's Co-ordinates' section of this manual. To display 
a horizontal grid, on the View menu point to Grid lines and then click Left or Right, depending which axis 
is to be used for the grid. To display a vertical grid, on the View menu point to Grid lines and then click 
Time axis, see the 'Display a Grid on a Graph' section of this manual. To display data that 963 has recorded 
for the graph, on the Data menu click Load Recorded Data, see the 'Playback a Recorded Graph' section 
of this manual for more details.  

4.5.6 Display Graph Data 

The data used to draw the graph can be displayed as a list of points. This feature is only available when accessing 
the 963 Server in graphic mode. 

To display the graph data: 
1. Display a graph from a schematic page or from the Device Viewer as described in the appropriate section 

of this manual.  
2. Click the List tab. The graph data is displayed. 

 

3. If there is more than on trace on the graph in the Selected trace box click the trace for which data is 
required a list of the traces will appear at the top of the window.  

4. To return to the graph display click the Graph tab. 
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4.5.7 Zoom in and Out of a Graph 

It is possible to zoom in and out on any graph so that the data can be more easily seen. This feature is only available 
when accessing the 963 Server in graphic mode. 

To zoom in on the graph: 
1. Display the graph as described in the ‘Display a Graph’ section of this manual. 
2. Click the mouse button and drag over the required area of the graph 
3. Release the mouse button. 

To return to the original zoom level: 
1. Press ALT+R, or right click the graph and click Zoom to original, or on the View menu click Zoom to 

original. 

4.5.8 Formatting Graphs 

4.5.8.1 Display a Grid on a Graph 

963 can display a vertical and/or horizontal grid on any graph. When a horizontal grid is selected, the grid can be 
based on either the left, or right hand axis. 

To display a horizontal grid: 
1. Display a graph from a schematic page or from the Device Viewer as described in the appropriate section 

of this manual.  
2. On the View menu point to Grid lines and then click Left or Right, depending which axis is to be used for 

the grid. 

To display a vertical grid: 
1. Display either a compact graph, or a precision graph as described in the appropriate section of this manual.  
2. On the View menu point to Grid lines and then click Time axis. 

Note that this feature is only available accessing the 963 Server in graphic mode. 

4.5.8.2 Display a Point's Co-ordinates 

The co-ordinates of points on the graph can be displayed in the trace value window. The window displays the time 
and value of the point closest to the position of the mouse, as the mouse is moved the value will change. 

To display a point’s co-ordinates: 
1. Display a graph from a schematic page or from the Device Viewer as described in the appropriate section 

of this manual.  
2. Press ALT+V or right click the graph and click Show trace value window, or on the View menu click 

Show trace value window. 
3. Move the mouse over the point whose co-ordinates are required. 

Note that this feature is only available accessing the 963 Server in graphic mode. 

4.5.9 Display Logged Data 

When you are accessing the 963 Server in text mode you can display information logged in a controller as a list 
points.  

To display a list of points: 
1. Access the 963 Server as described in the ‘Connect to the 963 Server’ section of this manual and display 

the page that contains the value for which the log is to be displayed as a list of points. 

2. Click for the required point. This displays a page listing the points. 
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4.6 Occupation Times 

4.6.1 View Occupation Times 

4.6.1.1 View Normal Occupation Times 

To view the normal occupation times for a diary group: 
1. Access the 963 Server as described in the ‘Connect to the 963 Server’ section of this manual. 
2. Display the page containing the button that provides access to the diary group, and click the button. 

Or 

Click Diary. A separate window is opened containing the diary groups, or folders containing diary groups. 
Select the required diary group by clicking it. If the required diary group is not visible navigate to it by 
clicking the required folder. To move back to the previous folder (parent) click Go up one folder level. 

Once you have selected the required diary group, a page is displayed that lists the time zones connected to 
it, and enables access to the exception templates and exceptions. 

3. Click Click here to go to the time schemes for this group.  
4. Click the label for the time scheme that defines the normal occupation times, this is indicated by the text 

Normal Times in the Time Scheme Type column. A display is opened similar to the one shown below. 

 

To view normal occupation times from a text mode schematic page: 
1. Display the schematic page containing the timezone's status as described in the ‘Display a Schematic Page’ 

section of this manual. 
2. Click Default week times for the required timezone. 
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4.6.1.2 View Exceptions 

To view the exceptions for a particular diary group: 
1. Access the 963 Server as described in the ‘Connect to the 963 Server’ section of this manual. 
2. Display the page containing the button that provides access to the diary group, as described in the ‘Display 

a Schematic Page’ section of this manual, and click the button. 

Or 

Click Diary. A separate window is opened containing the diary groups, or folders containing diary groups. 
Select the required diary group by clicking it. If the required diary group is not visible navigate to it by 
clicking the required folder. To move back to the previous folder (parent) click Go up one folder level. 

Once you have selected the required diary group a page is displayed that lists the time zones connected to 
it, and enables access to the exception templates and exceptions. 

3. Click Click here to go to the exceptions for this group. A display is opened similar to the one shown 
below. 

 

To return to the previous display click Return to the main group page. 

To occupation times for today and the next six days from a text mode schematic page: 
1. Display the schematic page containing the timezone's status as described in the ‘Display a Schematic Page’ 

section of this manual. 
2. Click Today and the next 6 days. 
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4.6.2 Adjust Occupation Times 

During the course of normal operation, it will be necessary to view the occupation times to ensure that the correct 
times are being worked so that unnecessary energy is not being used. 

It will also be necessary to change occupation times of the system, perhaps because the working times of an area 
have changed permanently. In which case, it is necessary to change the normal occupation times for the diary 
group(s) that are linked to the controllers in that area. If however, a particular day (e.g. a bank holiday) requires the 
occupation times to be different an exception should be added for that day only. These changes will automatically be 
sent to the controller as required. 

If a controller is operating the wrong times during a day it is possible to change the actual times stored in the 
controller by adjusting the time zones directly. 

4.6.2.1 Add an Exception 

Areas can be set to be occupied at times different to the normal occupation times (e.g. for bank holidays) by adding 
an exception to the diary group that is linked to the time zone controlling the occupation times for that area. 

To add an exception: 
1. View the exceptions for the diary group to which the exception is to be added as described in the ‘View 

Exceptions’ section of this manual.  
2. Click Add new exception. A display is opened. 
3. In the Label box enter a name for the exception. 
4. In the boxes opposite Start date click the required date, month, and year to specify the first date the 

exception times are to be used. 
5. In the boxes opposite End date click the required date, month, and year to specify the last date the 

exception times are to be used. 
6. If the exception is to be repeated each year select the Same each year check box. 
7. In the Time scheme box click the template that is to supply the times. The list will contain all the templates 

for the diary group. 
8. If the changes are to be sent to the controller immediately select the Tick this box to send changes 

immediately, otherwise changes will be sent at the group download time check box. 
9. Click Send adjustments. 

To return to the list of exceptions for the group click Click here to return to the group exceptions page. 

The exception can be edited in the same way. 

4.6.2.1.1 Edit an Exception 

To edit an exception: 
1. View the exceptions for the diary group containing the exception is to be edited as described in the View 

Exceptions’ section of this manual.  
2. Click the label of the exception that is to be edited  
3. Edit the exception as required. 
4. If the changes are to be sent to the controller immediately select the Tick this box to send changes 

immediately, otherwise changes will be sent at the group download time check box. 
5. Click Send adjustments. 

To return to the list of exceptions for the group click Click here to return to the group exceptions page. 

4.6.2.1.2 Delete an Exception 

To delete an exception: 
1. View the exceptions for the diary group from which the exception is to be deleted as described in the ‘View 

Exceptions’ section of this manual. 
2. Click the label of the exception that is to be deleted.  
3. Click Delete this exception. A dialogue box is displayed asking for confirmation of the deletion. 
4. Click OK. 
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4.6.2.2 Change Normal Occupation Times 

The normal occupation times for a diary group can be changed to enable the occupation times for the normal 
working week to be adjusted. 

To change the normal operating times for a diary group: 
1. View the normal occupation times that are to be edited as described in the ‘View Normal Occupation 

Times’ section of this manual.  
2. Scroll down the page to find the day for which the occupation times are to be adjusted. 
3. In the boxes in the Start and End columns enter start or stop times for each period.  

 For IQ3 controllers periods can be added by selecting the check box in the New column, then in the 
boxes in the Start and End columns entering start or stop times for the new period, and then clicking 

Send adjustments. Unwanted periods can be removed by selecting the check box next to the  and 
then clicking Send adjustments. 

 For pre IQ3 controllers unused periods should have both times set to 24:00. 

4. Click Send adjustments in the area that specifies the times. 
5. Repeat steps (3) and (4) for each day. 
6. If the changes are to be sent to the controller immediately select the Tick this box to send changes 

immediately, otherwise changes will be sent at the group download time check box.  
7. Once the operating times are correctly set up click Process time scheme adjustments. 

4.6.2.3 Adjust a Timezone 

The occupation times of the controllers on the IQ system (i.e. when they are in occupancy, current week) are set by 
the times defined in the diary group they belong to. It is possible to override those times. Adjusting the time in this 
way overrides the times specified by the 963’s diary by directly modifying the times stored in the controller. 

To adjust a time zone: 
1. Display the page containing the button or picture that enables the time zone to be adjusted, as a described in 

the ‘Display a Schematic Page’ section of this manual, and click the button or picture.  

Or 

View the time zone that is to be adjusted in the Device Viewer, as described in the ‘Display the IQ System’ 
section of this manual, right click the time zone that is to be adjusted, and click Adjust Point.  

2. If adjusting a time zone in a pre IQ3 controller a dialogue box is displayed asking if you what times are to 
be adjusted. Click Today and next 6 days to adjust the current week times, click Default week times to 
adjust the default times (standard week).  

The screen changes. 

3. Scroll down to the day for which the occupation times are to be changed. 
4. In the boxes in the Start and End columns enter start or stop times for each period.  

 For IQ3 controllers periods can be added by selecting the check box in the New column, then in the 
boxes in the Start and End columns entering start or stop times for the new period, and then clicking 

Send adjustments. Unwanted periods can be removed by selecting the check box next to the  and 
then clicking Send adjustments. 

 For pre IQ3 controllers unused periods should have both times set to 24:00. 

5. Click Send adjustments in the area that specifies the times. 
6. Repeat steps (4) and (5) for each day. 
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4.7 Display the IQ System 

If you are accessing the 963 Server in graphics mode the Device Viewer enables inputs, outputs, adjustments, time 
zones, and critical alarms from the selected part of the system to be displayed. E.g. if the internetwork is selected, all 
values from the internetwork are displayed. If a particular Lan is selected, only values from that Lan are displayed. 
The types of values displayed can be filtered by type (inputs, outputs, adjustments, time zones, and critical alarms).  

To display the Device Viewer: 
1. Connect to the 963 Server as described in the ‘Connect to 963 Server’ section of this manual. 
2. Log in by entering your user name and password and clicking Log in as described in the ‘Log In’ section of 

this manual. The 963 Server’s Start up page is displayed. This page provides access to schematic pages, the 
Device Viewer, and will display the alarm viewer if you have access to it. 

3. Click Device Viewer. The Device Viewer is displayed in a separate window. 
4. Double click on the site containing the values that are to be displayed. 
5. Click the Site, Lan, or Device containing the values that are to be displayed. 
6. Click one or more of the buttons to display those item types. Selected items will change colour. 

Icon What is Displayed 

 
Sensors 

 Digital Inputs 

 
Virtual sensors (calculated MKT values) 

 
Critical Alarms 

 
Knobs 

 
Switches 

 Time Zones 

 Analogue Driver 

 Digital Driver 

 
Plots 

To select all inputs click Inputs, to select all adjustments click Adjustments, and to select all drivers click 
Drivers. All the icons for the select type will turn red. To de-select all selected inputs click Inputs, to de-
select all selected adjustments click Adjustments, and to de-select all selected drivers click Drivers.  

7. If the display is to be filtered further enter the required search string into the Search box, and click 

. This causes 963 to only display items of the selected item types whose label matches the search 
string. An asterisk ‘*’ can be used as a wildcard, to specify any number of any characters.  
Normally the values are updated every 30s, however they can be updated manually when required by 

clicking . Values can be adjusted by right-clicking the value that is to be adjusted, and clicking 
Adjust Point. Values can be graphed by right -clicking the value and clicking Graph Point(s).  

4.8 Display IQ3 Web Pages 

963 can display IQ3 Web Pages. 

Note this facility is not available for BACnet devices. 

To display IQ3 web pages: 
1. Connect to the 963 Server as described in the ‘Connect to 963 Server’ section of this manual. 
2. Log in by entering your user name and password and clicking Log in as described in the ‘Log In’ section of 

this manual. The 963 Server’s Start up page is displayed. This page provides access to schematic pages, the 
Device Viewer, and will display the alarm viewer if you have access to it. 

3. Click Device Viewer. The Device Viewer is displayed in a separate window. 
4. Double click on the site containing the controller. 
5. Click the, Lan containing the controller. 
6. Right-click the device, and click IQ Configuration. The selected controller's 'Welcome' web page will be 

displayed in a separate web browser window. 
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4.9 Display the 963's Startup Page 

When you log in the 963’s start up page is displayed, however when you display schematic pages or the Device 
Viewer it may become hidden. 

To display the 963’s start up page: 
1. Hold down the ALT key and press the TAB key until the start up page is selected. 
2. Release both keys. The 963’s start up page will be displayed. 

4.10 Enter Configuration Mode on Pre IQ3 Controllers 

963 allows access to configuration mode on IQ System devices that support configuration mode. Once in this mode, 
simple adjustments can be made to the strategy. When in configuration mode, 963 is effectively converted into a 
terminal, all the screen prompts originate from the controller, and all keyboard inputs are sent to the outstation when 
the Submit is clicked. Configuration mode for any IQ System device on the network that supports configuration 
mode can be accessed from the Device Viewer. Buttons can also be set up on pages to provide access to 
configuration mode for a particular device. 

Note this facility is not available for BACnet devices. 

To enter configuration mode from the Device Viewer: 
1. Display the IQ System as described in the ‘Display the IQ System’ section of this manual. 
2. Navigate to the required controller as described in the ‘Display the IQ System’ section of this manual. 
3. Right-click the device, and click IQ Configuration. Configuration mode on that device will now be open. 
4. Configuration commands can be typed in on the keyboard. All the configuration information will be 

displayed in the configuration viewer. 

To enter configuration mode using a button: 
1. Display the page containing the button that provides access to the device’s configuration mode adjusted as 

described in the ‘Display a Schematic Page’ section of this manual. 
2. Click the button/picture or link that provides access to the device’s configuration mode. Configuration 

mode on that device will now be open. 

To send configuration commands to the device: 
1. Once in configuration mode, enter the configuration command in the text box at the bottom of the screen. 
2. Press ENTER or click Submit.  

The system prompts the available functions; the upper case character in each prompt is the key to be used to select 
the function. Most functions also require an additional numeric value. To exit from any page of data and save any 
changes, made, press X and click Submit. To exit from any page of data and not save any changes made, press Q 
click Submit. If the top page of the configuration prompts (Type Sensor - etc.) is answered with an X, the outstation 
will exit configuration mode. The outstation will continue with its real time control tasks whilst in configuration 
mode, but will NOT respond to other (non-configuration) communications. It is therefore very important that the 
user ensures that the device has exited configuration mode BEFORE returning 963 to Supervisor mode. Sending 
more X+ENTER commands will do no harm, so if in doubt, press X click Submit before leaving configuration 
mode. The 963 will return to normal mode when the outstation responds with ‘Exit from Utility’. 

Note that if a device is left in configuration mode, it will time out after 15 minutes. 

4.11 Log Off a Client User 

Client users that are currently logged in can be logged off by users who have the rights to configure workgroups and 
user, or for 963 Secure belong to the 'System Administrator' workgroup will be logged out of a previous session if 
they attempt to log in from another client. 

To log a client off: 
1. Access the 963 Server as described in the ‘Connect to the 963 Server’ section of this manual. 
2. Log In as described in the 'Log In' section of this manual. 
3. Click Server Status. The Server Status Page is displayed. 

4. In the Clients area click Log out user for the required user. 

4.12 Setup Exception Templates 

Exception templates enable times for exceptions to be predefined e.g. for bank holidays etc which can be used when 
adding and exception. The templates can either define occupation times for a single day (Special Day Templates), or 
for an entire week (Week Set Templates). This feature allows different occupation times to be set up for each day of 
the week. Each different Diary Group can contain its own exception templates, allowing the same name to be used 
within different groups, but defining different occupation times. 
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4.12.1 Add a Week Set Template 

Week set templates can be added to provide a template of occupation times for a weekly pattern. 

To add a week set template: 
1. Access the 963 Server as described in the ‘Connect to the 963 Server’ section of this manual. 
2. Display the page containing the button that provides access to the diary group, and click the button. 

Or 

Click Diary. A separate window is opened containing the diary groups, or folders containing diary groups. 
Select the required diary group by clicking it. If the required diary group is not visible navigate to it by 
clicking the required folder. To move back to the previous folder (parent) click Go up one folder level. 

Once you have selected the required diary group, a page is displayed that lists the time zones connected to 
it, and enables access to the exception templates and exceptions. 

3. Click Click here to go to the time schemes for this group.  
4. Click New week set. A display is opened similar to the one shown below. 

 

5. In the Label box enter the name for the template. 
6. In the Colour box click the colour that is to be used to represent days that use these times. 
7. Click Update label and colour. 
8. In the boxes in the Start and End columns enter start or stop times for each period.  

 For IQ3 controllers periods can be added by selecting the check box in the New column, then in the 
boxes in the Start and End columns entering start or stop times for the new period, and then clicking 

Send adjustments. Unwanted periods can be removed by selecting the check box next to the  and 
then clicking Send adjustments. 

 For pre IQ3 controllers unused periods should have both times set to 24:00. 

9. Click Send adjustments in the area that specifies the times. 
10. Repeat steps (8) and (9) for each day. 
11. If the changes are to be sent to the controller immediately click the Tick this box to send changes 

immediately, otherwise changes will be sent at the group download time check box. 
12. Once the operating times are correctly set up click Process time scheme adjustment. 
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4.12.2 Add a Special Day Template 

Day templates can be added to provide a template of occupation times for single day.  

To add a special day template: 
1. Access the 963 Server as described in the ‘Connect to the 963 Server’ section of this manual. 
2. Display the page containing the button that provides access to the diary group, and click the button. 

Or 

Click Diary. A separate window is opened containing the diary groups, or folders containing diary groups. 
Select the required diary group by clicking it. If the required diary group is not visible navigate to it by 
clicking the required folder. To move back to the previous folder (parent) click Go up one folder level. 

Once you have selected the required diary group, a page is displayed that lists the time zones connected to 
it, and enables access to the exception templates and exceptions. 

3. Click Click here to go to the time schemes for this group.  
4. Click New special day. A display is opened similar to the one shown below. 

 

5. In the Label box enter the name for the template. 
6. In the Colour box click the colour used to represent days that use these times. 
7. Click Update label and colour. 
8. In the boxes in the Start and End columns enter start or stop times for each period.  

 For IQ3 controllers periods can be added by selecting the check box in the New column, then in the 
boxes in the Start and End columns entering start or stop times for the new period, and then clicking 

Send adjustments. Unwanted periods can be removed by selecting the check box next to the  and 
then clicking Send adjustments. 

 For pre IQ3 controllers specify the start or stop times for each period in the Start and End boxes. If a 
period is not to be used set both times to 24:00. 

9. Click Send adjustments. 
10. If the changes are to be sent to the controller immediately click the Tick this box to send changes 

immediately, otherwise changes will be sent at the group download time check box. 
11. Once the operating times are correctly set up click Process time scheme adjustment. 
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4.12.3 Delete a Template 

Unused templates can be deleted. 

To delete a template: 
1. Access the 963 Server as described in the ‘Connect to the 963 Server’ section of this manual. 
2. Display the page containing the button that provides access to the diary group, and click the button. 

Or 

Click Diary. A separate window is opened containing the diary groups, or folders containing diary groups. 
Select the required diary group by clicking it. If the required diary group is not visible navigate to it by 
clicking the required folder. To move back to the previous folder (parent) click Go up one folder level. 

Once you have selected the required diary group, a page is displayed that lists the time zones connected to 
it, and enables access to the exception templates and exceptions. 

3. Click Click here to go to the time schemes for this group.  
4. Click Delete next to the template that is to be deleted. A dialogue box is displayed asking for confirmation 

of the deletion. 
5. Click OK. 

4.12.4 Edit a Template 

Once created a template can be edited to adjust the times, change the colour that represents it, or its name. 

To edit a template: 
1. Access the 963 Server as described in the ‘Connect to the 963 Server’ section of this manual. 
2. Display the page containing the button that provides access to the diary group, and click the button. 

Or 

Click Diary. A separate window is opened containing the diary groups, or folders containing diary groups. 
Select the required diary group by clicking it. If the required diary group is not visible navigate to it by 
clicking the required folder. To move back to the previous folder (parent) click Go up one folder level. 

Once you have selected the required diary group, a page is displayed that lists the time zones connected to 
it, and enables access to the exception templates and exceptions. 

3. Click Click here to go to the time schemes for this group.  
4. Click on the label of the template that is to be edited. 
5. Edit the template as required. 
6. If the label and colour have been changed click Update label and colour. 
7. If times have been changed click Process time scheme adjustment. 
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4.13 View Server Status 

If required information about the server’s status can be displayed. This is useful to the engineer if problems are 
encountered. 

To view server status: 
1. Access the 963 Server as described in the ‘Connect to the 963 Server’ section of this manual. 
2. Log In as described in the 'Log In' section of this manual. 
3. Click Server Status. The Server Status Page is displayed. 

Client users that are currently logging in can be logged out by clicking Log out user in the Clients section of the 
page. 

The information displayed is dependant on your access rights. If you have the correct authority the Server Status 
Page will contain the View remote connections button which displays the RemoteSiteDiallers Window which 
provides a list of all the currently connected remote sites, and allows the connection to be dropped by clicking on 
Drop Line next to the appropriate site. 
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5 ERROR MESSAGES 

If there is a problem finding the 963 on the TCP/IP network when attempting to access the 963 Server from a client 
standard error messages are displayed by the web browser. These messages are determined by the browser itself, 
and may be of the type the user is familiar with from normal Web browsing. If a connection is made to the 963 
Server, but for some reason access is denied to all or part of the 963 Server, the following error messages are 
provided by the 963 Server. 

Error 
Message 

Description 

Exceeded 
Licence Count 

The maximum number of clients allowed by the current licence for 963 Server is currently logged on. 
Try again later, or contact one of the currently logged on users, and ask the user to log out. 

Log Out 963 Server has logged the user out of the system automatically. Close the Web browser to complete 
the logout. 

Permission 
Denied 

You have attempted to access a part of the 963 Server for which they are not authorised. Contact the 
person in charge of the 963 Server to verify that you have permission to access the requested 
resource. 

Out of Hours The workgroup is linked to a diary group, and the user is trying to log in outside the permitted hours.

Config 
Session 
Denied  

You are not authorised to configure IQ controllers. Contact the person in charge of the 963 Server to 
verify that you have permission to access the requested resource. 
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